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About this document 

Version 

1.4.2 

Scope and purpose 

The AIROC™ Bluetooth® test and debug tool is a stand-alone, cross-platform tool for testing and debugging 
AIROC™ Bluetooth® devices. The tool communicates with Bluetooth® devices through a Host/Controller 
Interface (HCI) and supports UART and USB physical interfaces. The tool can:  

• Send HCI commands to Bluetooth® controllers 

• Receive HCI events from Bluetooth® controllers 

• Program Bluetooth® controllers 

• Run ACL, SCO, and ISOC throughput tests for Bluetooth® controllers 

Intended audience 

This document helps you understand how to use the AIROC™ Bluetooth® test and debug tool. 

Document conventions 

Convention Explanation 

Bold Emphasizes hotkeys and the names of menu items, tabs, buttons, labels and windows 

Italics Denotes file names and paths 

Courier New Denotes command line inputs 

File > New Indicates that a cascading sub-menu opens when you select a menu item 

Acronyms and abbreviations 

Term Explanation 

ACL Asynchronous connection-less link 

BIG Broadcast isochronous group 

BIS Broadcast isochronous stream 

BTP A preset file used to program AIROC™ Bluetooth® controllers 

CIG Connected isochronous group 

CIS Connected isochronous stream 

GUI Graphical user interface 

HCI Host/Controller interface 

ISOC Isochronous channel 

SCO Synchronous connection-oriented link 

UART Universal asynchronous receiver-transmitter 

USB Universal serial bus 
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Introduction 

1 Introduction 

1.1 System requirements 

The AIROC™ Bluetooth® test and debug tool supports the following operating systems: 

• Windows 10 and 11 64-bit 

• Ubuntu Linux 18.04 LTS, 20.04 LTS, and 22.04 LTS 

• macOS Big Sur, Monterey, and Ventura 

The following system configuration is recommended: 

• Processor: 1 GHz or faster 

• RAM: 4 GB or more 

• Hard disk space: 350 MB 

• Display: 1280x1024 or more 

1.2 Package contents 

The tool package contains: 

• airocbluetoothtoolgui executable – the GUI application. 

• airocbluetoothtoolconsole executable – the console application. 

• Drivers used to communicate with Bluetooth® devices: 

• BTWUSB driver (Windows only). 

• KitProg drivers (Windows only) 

• WICED UART driver (Windows only). 

• BTUSB driver (source code, Linux only). 

• BTCOMTT driver (the driver for kernel-mode throughput testing, Windows only). 

1.3 Supported devices 

The tool supports the following AIROC™ Bluetooth® devices. 

• Stand-alone Bluetooth® chips: 

• CYW20702/5/89071 

• CYW20730 

• CYW20732/6/7 

• CYW20733 

• CYW20703/4/6/7/34/89072 

• CYW20735B0 

• CYW20735B1 

• CYW20819/20 

• CYW20719/21/39 

• CYW20829 
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• Combo chips: 

• CYW4330/43303/40183 

• CYW43340 

• CYW4343W/4343A1/43438 

• CYW4343A2/43439 

• CYW4339/89335 

• CYW43455/4345C0 

• CYW4350C0/4354 

• CYW4354A2/4356 

• CYW4356A3/4354 

• CYW43569/43570 

• CYW4359D0/89459/5459x 

• CYW4373 

• CYW4349B1/4359B1/89359 

• CYW43012 

• CYW5557x/CYW89570 

• CYW55500 
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2 Installation procedures 

This section describes how to install the tool on different operating systems. 

2.1 Windows 

1. Run airocbluetoothtool-1.4.2.<build>-win-x64.exe. 

2. Follow the installation wizard instructions. 

Note: The airocbluetoothtool-1.4.2.<build>-win-x64.exe file may require Administrator privileges to 
install drivers and Microsoft Visual C++ Redistributable. 

2.2 Ubuntu Linux 

1. Open a terminal and navigate to the folder where the airocbluetoothtool-1.4.2.<build>-linux-x64.deb  file is 
located. 

2. Install the airocbluetoothtool-1.4.2.<build>-linux-x64.deb package. For example: 

sudo dpkg -i airocbluetoothtool-1.4.2.<build>-linux-x64.deb 

After installation, the application is located in /opt/Tools/AirocDebugTool/<version>. 

3. Navigate to the application folder and provide permissions for the ChipLoad and cgs executables. For 
example: 

cd /opt/Tools/AirocDebugTool/<version> 

sudo chmod +x ChipLoad 

sudo chmod +x cgs 

2.2.1 Build and install the BTUSB driver 

To connect to Bluetooth® devices using the USB transport on Ubuntu Linux, you should first build and install 
the BTUSB driver. The source code of the BTUSB driver is located in the drivers/btusb subdirectory of the 

installation directory. The BTUSB driver supports Linux kernel 5.8. 

To build and install the BTUSB driver: 

1. Disconnect all AIROC™ Bluetooth® devices from your computer. 

2. Open a terminal and navigate to the folder where the source code of the BTUSB driver is located. For 

example: 

cd /opt/Tools/AirocDebugTool/<version>/drivers/btusb 

3. Build and install the BTUSB driver: 

sudo make 

sudo chmod +x install.sh 

sudo ./install.sh 

Note: BTUSB is incompatible with BlueZ. Installing the BTUSB driver using install.sh will uninstall BlueZ 

if installed. 
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2.3 macOS 

1. Run the airocbluetoothtool-1.4.2.<build>-mac-x64.pkg file. 

2. Follow the installation wizard instructions. 
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3 GUI application 

This section describes how to run and use the GUI application. 

3.1 Open GUI application 

This section describes how to open the GUI application on different operating systems. 

3.1.1 Windows 

Navigate to the folder where the tool is installed, and run the airocbluetoothtoolgui.exe executable. 

3.1.2 Ubuntu Linux 

1. Open a terminal and navigate to the folder where the tool is installed. For example: 

cd /opt/Tools/AirocDebugTool/<version> 

2. Run the airocbluetoothtoolgui executable. For example: 

./airocbluetoothtoolgui 

3.1.3 macOS 

Navigate to the folder where the tool is installed, and run the airocbluetoothtoolgui executable. 

3.2 Command line options 

The following table lists command line options which you can use when opening the GUI. 

Option Description 

--help, -h, -? Displays help on command line options. 

--help-all Displays help on command line options including Qt specific 

options. 

--override-hcidef-file <filepath> Overrides the default HCI definition file. 

--override-lmpdef-file <filepath> Overrides the default LPM definition file. 

--override-hciacldef-file <filepath> Overrides the default HCI ACL definition file. 

--override-hciscodef-file <filepath> Overrides the default HCI SCO definition file. 

--override-hciisocdef-file <filepath> Overrides the default HCI ISOC definition file. 
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3.3 Main window description 

When you open the GUI application, the main window opens. 

 



  

User Guide 9 of 83 002-25714 Rev. *G 

  2024-10-29 

AIROC™ Bluetooth® test and debug tool user guide 
  

GUI application 

3.3.1 What’s New? dialog 

When you open the GUI application for the first time, the What’s New? dialog opens. 

 

To prevent the dialog from opening when the application starts, deslect the Show What's New? on startup 
check box and click OK. To open the dialog again, click Help > What's New? on the main menu. 

The main window contains the following menus: 

3.3.2 File menu 

• Select Device (Ctrl+O) – Open a device. 

• Exit (Alt+F4) – Exit the application. 

3.3.3 Tools menu 

• Log 

• Clear Log (Ctrl+D) – Clear the log window. 

• Collapse Logs/Expand Logs (Alt+D) – Collapse or expand the logs displayed in the log window. 

• Replay Log (Ctrl+R) – Show the Replay Log dialog allowing you to send HCI commands from a log file. 

• Show Log File – Show the location of the log file. 

• Options (Ctrl+L) – Show the Log Options dialog allowing you to set log options. 

• Rename Devices – Show the Rename Devices dialog allowing you to change names of the selected devices. 

• Restore Defaults – Reset all settings to their defaults. 

• Program Device (Ctrl+P) – Show the Program Device dialog allowing you to program AIROC™ Bluetooth® 

controllers connected to the computer. 

3.3.4 Window menu 

• Reset Window Layout – Reset window layout to default. 

3.3.5 Help menu 

• View Help (F1) – Open User Guide. 

• What’s New? – Open the What’s New? dialog. 
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• About AIROC™ Bluetooth® Test and Debug Tool – Show the About dialog displaying information about 

the tool. 

3.4 Select a device 

Before you can send HCI commands, receive HCI events, and run throughput tests for AIROC™ Bluetooth® 
devices, you need to select a device. Connect the device to your computer and do one of the following: 

• Select File > Select Device on the main menu, or press Ctrl+O. 

• Click Select Device on the main toolbar. 

• Click the Select Device link on the main window. 

The Select Device dialog opens. 

 

Select Transport and Port name. If you select UART, select also Baud rate and Flow control. Optionally, you 
can set Device name and check Open device tab side by side. 
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Click Open. When a device is selected, a new device tab or dockable window opens. 

 

To check if the device is connected successfully, you can send the Reset or Read_BD_ADDR command and see 

if the device responds in the log window. 

Note: For some adapter boards, you might need to install the FTDI virtual COM port (VCP) driver first. 

To select multiple devices, you can use the same GUI instance. To select a new device, connect the 
device to your computer and press Ctrl+O or click Select Device on the main toolbar. You can also 
select File > Select Device on the main menu. 

3.4.1 Select port name for UART 

If you select UART, the Port name drop-down list is auto-populated with available port names. Some AIROC™ 
Bluetooth® devices have two UART ports. Usually, you should use the port with the lower number to select the 

device. 

3.4.2 Select port name for USB 

If you select USB, the Port name drop-down list is not auto-populated and the port name should be entered. 

• On Windows, port names have the form usb<number>. The port name of the first device that is connected 

to the computer is usually usb0. Port names of other devices are usually subsequent: usb1, usb2 etc. 
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• On Linux, port names have the form btusb<number>. The port name of the first device that is connected to 

the computer is usually btusb0. Port names of other devices are usually subsequent: btusb1, btusb2 etc. 

• On mac OS, the USB transport is not supported. 

Note: The port name of a USB device can change after programming the device. 

3.4.3 Set device name 

Optionally, you can set Device name for the selected device. If not set, the device name is the same as the port 
name. 

3.4.4 Open device tab side by side 

When you select multiple devices using the same GUI instance, you may optionally check Open device tab side 
by side to open a new device tab side by side with a previously opened device tab. 

3.4.5 Rename selected device 

When a device is selected, to rename the device, select Tools > Rename Devices on the main menu. 

The Rename Devices dialog opens. 

  

To rename a device, set a new device name in the Device Name column and click OK. 

3.4.6 Disconnect from a selected device 

When a device is selected, to disconnect from the selected device, click Disconnect on the toolbar of the device 
tab or dockable window. Once disconnected, you cannot send HCI commands to the selected device, receive 

HCI events from the selected device, or run throughput tests for the selected device. 

 

To connect to the selected device again, click Connect on the toolbar of the device tab or dockable window. 
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Alternatively, to disconnect from the selected device, close the device tab or dockable window. On the 
confirmation dialog that opens, click Yes to confirm disconnecting from the device. 

 

3.5 Send HCI commands 

To send an HCI command to a selected device, on the device tab or dockable window, select the HCI tab and 
select Command Name on the list of supported commands. To filter commands by name, use the filter text 
box. The filter text box is case-insensitive. 

If the selected command has parameters, the list of command parameters is displayed on the right of the 
device tab or dockable window. 

 

To send the selected command, set command parameters (if any), and click Send or double-click the command 
name on the list of supported commands. 
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If the command generates HCI events, event information is printed in the log window. 

 

3.6 Receive HCI events 

When a selected device generates HCI events, event information is printed in the log window. 
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3.7 Reset a device 

To reset a selected device: 

1. Select the HCI tab. 

2. Select the Reset command. 

3. Click Send.  

 

Note: When you send the Reset command, the current operational state of the device is lost and the 
parameters, for which default values are defined, are reverted to the default values. 
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3.8 Read BD_ADDR of a device 

To read BD_ADDR of a selected device: 

1. Select the HCI tab. 

2. Select the Read_BD_ADDR command. 

3. Click Send.  

 

This generates the Connection Complete event, and information is printed in the log window. The BD_ADDR 
parameter of the Connection Complete event is the address of the device. 
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3.9 Increase connection accept timeout for a device 

To increase the connection accept timeout for a selected device: 

1. Select the HCI tab. 

2. Select the Write_Connection_Accept command. 

3. Set the Conn_Accept_Timeout command parameter. The maximum value of the Conn_Accept_Timeout 
command parameter is 0xB540, which corresponds to 29 seconds. 

4. Click Send.  
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3.10 Set baud rate for a selected UART device 

To set the baud rate for a selected UART device: 

1. Select the HCI tab. 

2. Select the Update_UART_Baud_Rate command. 

3. Set the Baud_Rate command parameter. 

4. Click Send. 
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3.11 Create an ACL connection between selected devices 

To create an ACL connection between two AIROC™ Bluetooth® devices: 

1. Select the devices. 

2. Increase connection accept timeout for the peripheral device (recommended). 

3. Enable scan for the peripheral device. 

4. Send Create_Connection to the central device. 

5. Send Accept_Connection_Request to the peripheral device. 

3.11.1 Select the devices 

Before you create an ACL connection between two devices, select the devices. To select the devices, connect 
two devices to your computer and follow the instructions from the Select a device section. 

 

When the devices are selected, it is recommended to send the Read_BD_ADDR command to both devices. This 
will auto-populate device address command parameters on the next steps of the process. 

3.11.2 Increase connection accept timeout for the peripheral device 

Before you create a connection between the selected devices, we recommend you increase the connection 
accept timeout for the peripheral device. Follow the instructions from the Increase connection accept timeout 

for a device section. 
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3.11.3 Enable scan for the peripheral device 

To create a connection between the selected devices, enable scan for the peripheral device: 

1. Select the HCI tab of the peripheral device. 

2. Select the Write_Scan_Enable command. 

3. Set the Scan_Enable parameter to Inquiry and Page Scan enabled. 

4. Click Send. 
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3.11.4 Send Create_Connection to the central device 

When scan for the peripheral device is enabled, to create a connection between the selected devices, send the 
Create_Connection command to the central device: 

1. Select the HCI tab of the central device. 

2. Select the Create_Connection command. 

3. Set command parameters. 

4. Click Send.  

 

Note: The BD_ADDR parameter of the Create_Connection command should be set to the address of the 
peripheral device. To get the address of the peripheral device, use the Read_BD_ADDR command. 
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3.11.5 Send Accept_Connection_Request to the peripheral device 

When the peripheral device gets a connection request from the central device, a dialog opens to ask if you want 
to accept the request. 

 

Note: Some AIROC™ Bluetooth® devices may need antennas. If the connection request dialog does not 
open, check if the devices need antennas and, if yes, check if the antennas are connected to the 
devices. 

To accept the request, click Yes. On the next dialog that opens, set parameters of the 
Accept_Connection_Request command and click Send. The Accept_Connection_Request command should 

be sent to the peripheral device within the connection accept timeout. 

 

Note: The BD_ADDR parameter of the Accept_Connection_Request command should be set to the 
address of the central device. To get the address of the central device, use the Read_BD_ADDR 

command. 
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If the connection is created successfully, the Connection Complete event is generated for both devices. Event 
information is printed in the log window. The Connection_Handle parameter of the Connection Complete 

event is the handle of the created connection. 

Note: The connection handle for the central device and the connection handle for the peripheral device 
may have different values. 

 

Note: When a connection request is received, if you click No to reject the connection request, the 
Reject_Connection_Request command should be sent to the peripheral device within the 
connection accept timeout. 

If you do not send the Accept_Connection_Request or Reject_Connection_Request command 

within the connection accept timeout, the Connection Complete event with Connection Timeout 

Exceeded status is generated for both devices.  

 

Sending the Accept_Connection_Request or Reject_Connection_Request command after the 
timeout exceeds will end with the Invalid HCI Command Parameters status. 
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3.12 Create an LE connection between selected devices 

To create an LE connection between two AIROC™ Bluetooth® devices: 

1. Select the devices. 

2. Enable advertising on the peripheral device. 

3. Send LE_Create_Connection to the central device. 

3.12.1 Select the devices 

Before you create an LE connection between two devices, select the devices. To select the devices, connect two 
devices to your computer and follow the instructions from the Select a device section. 

3.12.2 Enable advertising on the peripheral device 

To create an LE connection between the selected devices, enable advertising for the peripheral device: 

1. Select the HCI tab of the peripheral device. 

2. Select the LE_Set_Advertise_Enable command. 

3. Set the Advertising_Enable parameter to Advertising is enabled. 

4. Click Send. 
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Note: You need to enable advertising on the peripheral device every time when you create an LE 
connection. 

3.12.3 Send LE_Create_Connection to the central device 

When advertising for the peripheral device is enabled, to create an LE connection between the selected 
devices, send the LE_Create_Connection command to the central device. To send the LE_Create_Connection 
command to the central device: 

1. Select the HCI tab of the central device. 

2. Select the LE_Create_Connection command. 

3. Set command parameters. 

4. Click Send.  

 

Note: The Peer_Address parameter of the Create_Connection command should be set to the address of 

the peripheral device. To get the address of the peripheral device, use the Read_BD_ADDR 
command. 

To make the LE connection more stable, you may want to increase the value of the 
Supervision_Timeout parameter. The maximum value of the Supervision_Timeout parameter is 

0xC80. 
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If the connection is created successfully, the LE Connection Complete Event event is generated for both 
devices. Event information is printed in the log window. The Connection_Handle parameter of the LE 

Connection Complete Event is the handle of the created connection. 

Note: The connection handle for the central device and the connection handle for the peripheral device 
may have different values. 
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3.13 ACL throughput tests 

When a connection between the selected devices is created, you can run ACL throughput tests to check how 
fast ACL data is transferred between the devices. 

Note: To run ACL throughput tests for UART devices, we recommend you set the baud rate for both 
devices to 3000000 bps. 

3.13.1 ACL transmit test 

To check how fast ACL data is transmitted by a Bluetooth® controller, run the ACL transmit test: 

1. Select the ACL Throughput Test tab. 

2. Expand the Transmit test section of the ACL test parameters column. 

3. Set test parameters. 

4. Click Start test. 

  

The following table lists parameters of the ACL transmit test. 

Parameter Description Values 

Connection handle 
The connection handle of the connection 

between the devices. 
A valid connection handle. 
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Parameter Description Values 

Connection type Defines the type of connection. 

Auto-detect 

Classic 

LE 

Operation type Defines the operation type. 
Run throughput test 

Send ACL data 

Mode Defines the data transfer mode. 
POINT_TO_POINT 

ACTIVE_PERIPHERAL_BROADCAST 

Send on first receive 

If checked, data transmission starts only 

when the first byte is received from another 

device. The ACL receive test for the same 

device should be started first. 

Checked or unchecked. 

Packet boundary flag 
Defines the packet boundary flag. Enabled if 

Operation type is set to Send ACL data. 

START_NON_FLUSHABLE_PACKET 

CONTINUATION_PACKET 

START_OF_PACKET 

Fixed write size 

(bytes) 

Defines the size of data blocks. If not set, the 

size of data blocks is defined by the size of 

the ACL buffer. 

Integer values between 1 and 65535. 

Isochronous interval 

(ms) 

Defines the interval between data blocks (in 

milliseconds). If not set, the Number of 

Completed Packets event is used to define 

when a data block can be sent. 

Integer values between 1 and 65535. 

Data pattern Sets the data that should be transmitted. 

If ASCII is not checked, a space-separated 

sequence of bytes. 

If ASCII is checked, a valid ASCII string. 

Data file 
A data file from which the data to transmit 

should be read.  
The absolute path to an existing file. 

Audio file 

A WAV audio file from which the audio data 

to transmit should be read. The tool will 

encode the audio data using the SBC codec 

before transmission. 

The absolute path to an existing file. 

Repeat count 
Defines how many times the data pattern, 

data file or audio file should be transmitted. 
Integer values between 1 and 2147483647. 

Duration (sec) 

Expected minimum duration of the test (in 

seconds). The actual duration of the test can 

be longer. 

Integer values between 1 and 2147483647. 

Total bytes 
The total number of bytes that will be 

transmitted (read-only). 

Integer values, or N/A if the total number of 

bytes cannot be defined. 

Measurement interval 

(ms) 

Defines the time interval (in milliseconds) 

which is used to calculate throughput. At 

any moment of time, the instant throughput 

is calculated as the number of bytes, that 

were sent during the measurement interval, 

divided by the time interval. Throughput 

values can be calculated only when the 

duration of the test is longer than the 

measurement interval. 

Integer values between 500 and 2147483647. 
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Parameter Description Values 

Sync with 

Allows to synchronize the transmit test and 

the receive test for another device. If 

checked, the receive test for the other device 

is started automatically before the transmit 

test starts. Parameters of the transmit and 

receive tests are synchronized. 

A valid port name of a selected device. 

To check test results, expand the Transmit test section of the ACL test results column. The following table 
lists test result parameters. 

Parameter Description 

Enqueued (bytes) The number of bytes that were sent to the Bluetooth® controller. 

Sent (bytes) 
The number of bytes that were completed (transmitted or flushed) by the Bluetooth® 

controller. 

Elapsed time Duration of the test. 

Avg. throughput (kbps) 

The average transmit throughput (in kilobytes per second). Transmit throughput is 

calculated as the number of bytes, completed (transmitted or flushed) by the 

controller within the measurement time interval, divided by the time interval. 

Min. throughput (kbps) The minimum transmit throughput (in kilobytes per second). 

Max. throughput (kbps) The maximum transmit throughput (in kilobytes per second). 

First byte time Indicates when the first byte was sent to the Bluetooth® controller. 

Last byte time Indicates when the last byte was sent to the Bluetooth® controller. 

Note: To save test results to a text file, click the Save… link located above the test results section.  
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3.13.2 ACL receive test 

The ACL receive test checks how fast ACL data is received by a Bluetooth® controller. To run the ACL receive 
test: 

1. Select the ACL Throughput Test tab. 

2. Expand the Receive test section of the ACL test parameters column. 

3. Set test parameters. 

4. Click Start test.  

  

The following table lists parameters of the ACL receive test. 

Parameter Description Values 

Connection handle 
The connection handle of the connection 

between the devices. 
A valid connection handle. 

Delay tolerance (ms) 

Acceptable time interval (in milliseconds) 

between the time when data is sent to the 

transmitting Bluetooth® controller and the 

time when the data is received by the receiving 

Bluetooth® controller. The measured intervals 

can be larger than real values. 

Integer values between 1 and 65535. 
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Parameter Description Values 

Data pattern The data that is expected to be received. 

If ASCII is not checked, a space-separated 

sequence of bytes. 

If ASCII is checked, a valid ASCII string. 

Data file 
A data file with the data that is expected to be 

received. 
The absolute path to an existing file. 

Audio file 
A WAV audio file with the audio data that is 

expected to be received  
The absolute path to an existing file. 

Repeat count 
Defines how many times the data pattern, data 

file or audio file is expected to be received. 

Integer values between 1 and 

2147483647. 

Save to file 

Defines if the received data should be saved to 

a file. If Audio file is selected, the tool will 

decode the received data using the SBC codec. 

The absolute path to the file where the 

received data should be saved. 

Total bytes 
The total number of bytes that are expected to 

be received (read-only). 

Integer values, or N/A if the total number 

of bytes cannot be defined. 

Measurement interval 

(ms) 

Defines time interval (in milliseconds) which is 

used to calculate throughput. At any moment 

of time, the instant throughput is calculated as 

the number of bytes, that were received during 

the measurement interval, divided by the time 

interval. Throughput values can be calculated 

only when the duration of the test is longer 

than the measurement interval. 

Integer values between 500 and 

2147483647 

Sync with 

Allows to synchronize the receive test and the 

transmit test for another device. If checked, 

the transmit test for another device is started 

automatically after the receive test starts. 

Parameters of the receive and transmit tests 

are synchronized. 

A valid port name of a selected device. 

To check test results, expand the Receive test section of the ACL test results column. The following table lists 
test result parameters. 

Parameter Description 

Received (bytes) The number of bytes that were received. 

Elapsed time Duration of the test. 

Avg. throughput (kbps) 

The average receive throughput (in kilobytes per second). Receive throughput is 

calculated as the number of bytes, received within the measurement interval, divided 

by the time interval. 

Min. throughput (kbps) The minimum receive throughput (in kilobytes per second). 

Max. throughput (kbps) The maximum receive throughput (in kilobytes per second). 

First byte time Indicates when the first byte was received. 

Last byte time Indicates when the last byte was received. 

Bit errors The total number of bits that were received incorrectly. 

Delayed packets 
The total number of packets that were delayed by more than the value of delay 

tolerance. The measured intervals can be greater than real values. 

Average delay (ms) The average delay of a packet (in milliseconds). 

Maximum delay (ms) The maximum delay of a packet (in milliseconds). 

Note: To save test results to a test file, click the Save… link located above the test results section. 
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The receive test stops automatically if the expected number of bytes is known and received. Otherwise, you 
need to stop the receive test manually by clicking Abort. 

3.13.3 Simultaneous ACL throughput tests 

To run ACL transmit or receive throughput tests for multiple connections, in test settings, click the ellipsis 
button next to Connection handle. The Connection Handles dialog opens. 

 

In the Connection Handles dialog, enter the handles of connections for which you want to run the test, and click 
OK. In test settings, use the Connection handle drop-down list to switch between the connection handles. 
When you click Start test, the test is started for all connection handles. 

Note: When you run a throughput test for multiple connections, you cannot synchronize the receive and 
transmit tests. 

3.14 Create an SCO connection between selected devices 

To create an SCO connection between two AIROC™ Bluetooth® devices: 

1. Select the devices. 

2. Create an ACL connection between the selected devices. 

3. Increase connection accept timeout for the peripheral device (recommended). 

4. Send Setup_Synchronous_Connection to the central device. 

5. Send Accept_Synchronous_Connection_Request to the peripheral device. 

3.14.1 Select the devices 

Before you create an SCO connection between two devices, select the devices. To select the devices, connect 
two devices to your computer and follow the instructions from the Select a device section. 

3.14.2 Create an ACL connection between the selected devices 

To create an SCO connection between the selected devices, create an ACL connection between the devices. 
Follow the instructions from the Create an ACL connection between selected devices section. 

3.14.3 Increase connection accept timeout for the peripheral device 

Before you send the Setup_Synchronous_Connection command to the central device, we recommend you 
increase the connection accept timeout for the peripheral device. Follow the instructions from the Increase 

connection accept timeout for a device section. 
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3.14.4 Send Setup_Synchronous_Connection to the central device 

When the ACL connection is created, to create an SCO connection, send the Setup_Synchronous_Connection 
command to the central device: 

1. Select the HCI tab of the central device. 

2. Select the Setup_Synchronous_Connection command. 

3. Set command parameters. 

4. Click Send.  

 

Note: The Connection_Handle parameter of the Setup_Synchronous_Connection command should be 
set to the connection handle of the ACL connection. Other parameter values should correspond to 
the audio data that will be transmitted. 
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3.14.5 Send Accept_Synchronous_Connection_Request to the peripheral device 

When the peripheral device gets the synchronous connection request from the central device, a dialog opens to 
ask if you want to accept the request. 

 

To accept the request, click Yes. 

On the next dialog that opens, set parameters of the Accept_Synchronous_Connection_Request command 
and click Send. The Accept_Synchronous_Connection_Request command should be sent to the peripheral 

device within the connection accept timeout. 

 

Note: The parameters of the Accept_Synchronous_Connection_Request command should match the 

parameters of the synchronous connection between the devices. The BD_ADDR parameter of the 
Accept_Synchronous_Connection_Request command should be set to the address of the central 
device. To get the address of the central device, use the Read_BD_ADDR command. 

If the connection is created successfully, the Synchronous Connection Complete event is generated. Event 
information is printed in the log window. The Connection_Handle parameter of the Synchronous Connection 
Complete event is the connection handle of the created connection. 

Note: The connection handle for the central device and the connection handle for the peripheral device 
may have different values. 
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Note: When the synchronous connection accept request is received, if you click No to reject the 
connection request, the Reject_Synchronous_Connection_Request command should be sent to 

the peripheral device within the connection accept timeout. 

3.15 SCO throughput tests 

When the SCO connection between the selected devices is created, you can run SCO throughput tests to check 

how fast SCO data is transferred between the devices. 

Note: To run SCO throughput tests for UART devices, we recommend you set the baud rate for both 

devices to 3000000 bps. 

For some AIROC™ Bluetooth® devices, before you run SCO throughput tests, you may need to send 

the Write_SCO_PCM_Int_Param command. 
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3.15.1 SCO transmit test 

The SCO transmit test checks how fast SCO data is transmitted by a Bluetooth® controller. To run the SCO 
transmit test: 

1. Select the SCO Throughput Test tab. 

2. Expand the Transmit test section of the SCO test parameters column. 

3. Set test parameters. 

4. Click Start test.  

  

The following table lists parameters of the SCO transmit test. 

Parameter Description Values 

Connection handle Connection handle of the SCO connection. A valid connection handle. 

Audio file 
A WAV audio file from which the audio data to 

transmit should be read. 
The absolute path to an existing WAV file. 

CVSD 

Enables or disables CVSD encoding. If enabled, 

the tool will encode audio data using the CVSD 

codec and pass the encoded data to the 

controller. Please make sure that the audio 

data is not encoded on the controller to avoid 

double encoding. Enabled only if Audio file is 

selected. 

Checked or unchecked. 
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Parameter Description Values 

Repeat count 
Defines how many times the audio file should 

be sent. 
Integer values between 1 and 2147483647. 

Duration (sec) 

Expected minimum duration of the test (in 

seconds). The actual duration of the test can 

be longer. 

Integer values between 1 and 2147483647. 

Write size 

Defines how many samples in a transaction 

slot can be filled. In case of USB transport, 

available only on Linux. 

Integer values between 1 and 127. 

Use connection settings 

Defines whether to use the settings that were 

set when creating the SCO connection or 

define the connection settings manually. 

Checked or unchecked. 

Transmit bandwidth 
The value of transmit bandwidth. Available 

only if Use connection settings is unchecked. 

Should be set to the correct value for the 

created connection. 

Receive bandwidth 
The value of receive bandwidth. Available only 

if Use connection settings is unchecked. 

Should be set to the correct value for the 

created connection. 

Sample size 
Defines sample size. Available only if Use 

connection settings is unchecked. 

Should be set to the correct value for the 

created connection. 

Input coding 
Defines input coding. Available only if Use 

connection settings is unchecked. 

Should be set to the correct value for the 

created connection. 

Input data format 
Defines input data format. Available only if Use 

connection settings is unchecked. 

Should be set to the correct value for the 

created connection. 

Air coding 
Defines air coding. Available only if Use 

connection settings is unchecked. 

Should be set to the correct value for the 

created connection. 

PCM 
The value of PCM. Available only if Use 

connection settings is unchecked. 

Should be set to the correct value for the 

created connection. 

Sync with 

Allows to synchronize the transmit test and 

the receive test for another device. If checked, 

the receive test for another device is started 

automatically before the transmit test starts. 

Parameters of the receive and transmit tests 

are synchronized. 

A valid port name of a selected device. You 

should first establish a SCO connection 

between the devices. 

To check transmit test results, expand the Transmit test section of the SCO test results column. The following 

table lists test result parameters. 

Parameter Description 

Total (samples) 
The total number of samples to be transmitted, or N/A if the total number of 

samples cannot be defined. 

Sent (samples) The number of samples that were transmitted. 

Elapsed time Duration of the test. 

Delayed writes The number of blocks and samples that were delayed. 

Note: To save test results to a text file, click the Save… link located above the test results section.  
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3.15.2 SCO receive test 

The SCO receive test checks how fast SCO data is received by a Bluetooth® controller. To run the SCO receive 
test: 

1. Select the SCO Throughput Test tab. 

2. Expand the Receive test section of the SCO test parameters column. 

3. Set test parameters. 

4. Click Start test.  

  

The following table lists parameters of the SCO receive test. 

Parameter Description Values 

Connection 

handle 
Connection handle of the SCO connection. A valid connection handle. 

Save to file 
Defines if the received data should be saved 

to a file. 

The absolute path to the WAV file to save the 

received data to. 

CVSD 

Enables or disables CVSD decoding. If 

enabled, the tool will decode the received 

audio data using the CVSD codec. 

Checked or unchecked. 

Use connection 

settings 

Defines whether to use the settings that were 

set when creating the SCO connection or 

define the connection settings manually. 

Checked or unchecked. 
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Parameter Description Values 

Transmit 

bandwidth 

The value of transmit bandwidth. Available 

only if Use connection settings is 

unchecked. 

Should be set to the correct value for the created 

connection. 

Receive 

bandwidth 

The value of receive bandwidth. Available 

only if Use connection settings is 

unchecked. 

Should be set to the correct value for the created 

connection. 

Sample size 
Defines sample size. Available only if Use 

connection settings is unchecked. 

Should be set to the correct value for the created 

connection. 

Input coding 
Defines input coding. Available only if Use 

connection settings is unchecked. 

Should be set to the correct value for the created 

connection. 

Input data 

format 

Defines input data format. Available only if 

Use connection settings is unchecked. 

Should be set to the correct value for the created 

connection. 

Air coding 
Defines air coding. Available only if Use 

connection settings is unchecked. 

Should be set to the correct value for the created 

connection. 

PCM 
The value of PCM. Available only if Use 

connection settings is unchecked. 

Should be set to the correct value for the created 

connection. 

Sync with 

Allows to synchronize the receive test and the 

transmit test for another device. If checked, 

the transmit test for another device is started 

automatically after the receive test starts. 

Parameters of the receive and transmit tests 

are synchronized. 

A valid port name of a selected device. 

To check test results, expand the Receive test section of the ACL test results column. The following table lists 

test result parameters and explains their meanings. 

Parameter Description 

Total (samples) 
The number of samples that are expected to be received, or N/A if the total number of 

samples cannot be defined. 

Received (samples) The number of received samples. 

Elapsed time Duration of the test. 

First byte time Indicates when the first byte was received. 

Last byte time Indicates when the last byte was received. 

Note: The SCO receive test should always be stopped manually. 
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3.15.3 Simultaneous SCO throughput tests 

To run SCO transmit or receive throughput tests for multiple connections, in test settings, click the ellipsis 
button next to Connection handle. The Connection Handles dialog opens. 

 

In the Connection Handles dialog, enter the handles of connections for which you want to run the test, and click 
OK. In test settings, use the Connection handle drop-down list to switch between the connection handles. 
When you click Start test, the test is started for all connection handles. 

Note: When you run a throughput test for multiple connections, you cannot synchronize the receive and 
transmit tests. 

For a USB device, you can run an SCO throughput test for at most three connections. 

For USB devices, test settings should be the same for all connections. 

3.16 Create a CIS between selected devices 

Note: Isochronous channels are supported only by devices that support Bluetooth® 5.2 or later. 

To create a CIS between two devices: 

1. Select the devices. 

2. Enable isochronous channels for the selected devices. 

3. Create an LE connection. 

4. Set CIG parameters for the central device. 

5. Increase connection accept timeout for the peripheral device (recommended). 

6. Send LE_Create_CIS to the central device. 

7. Send LE_Accept_CIS_Request to the peripheral device. 

3.16.1 Select the devices 

Before you create a CIS between two devices, select the devices. To select the devices, connect two AIROC™ 
Bluetooth® devices to your computer and follow the instructions from the Select a device section. 
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3.16.2 Enable isochronous channels for the selected devices 

To create a CIS between the selected devices, enable isochronous channels for the selected devices: 

1. Select the HCI tab. 

2. Select the LE_ISO_Set_Host_Feature command. 

3. Set the Bit_Number command parameter to 0x20 and the Bit_Value command parameter to Host feature 
is enabled. 

4. Click Send.  

 

3.16.3 Create an LE connection 

When isochronous channels are enabled for the selected devices, to create a CIS between the selected devices, 
create an LE connection between the selected devices. Follow the instructions from the Create an LE 

connection between selected devices section. 
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3.16.4 Set CIG parameters for the central device 

When the LE connection between the selected devices is created, to create a CIS between the selected devices, 
set CIG parameters for the central device: 

1. Select the HCI tab of the central device. 

2. Select the LE_Set_CIG_Parameters or LE_Set_CIG_Parameters_Test command. 

3. Set command parameters. 

4. Click Send.  

 

If CIG parameters for the central device are set successfully, the Command Complete event is generated, and 

CIS connection handles are reported. 

3.16.5 Increase connection accept timeout for the peripheral device 

Before you send the LE_Create_CIS command to the central device, we recommend you increase the 
connection accept timeout for the peripheral device. Follow the instructions from the Increase connection 
accept timeout for a device section. 
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3.16.6 Send LE_Create_CIS to the central device 

When CIG parameters for the central device are set, to create a CIS between the selected devices, send the 
LE_Create_CIS command to the central device: 

1. Select the HCI tab of the central device. 

2. Select the LE_Create_CIS command. 

3. Set command parameters. 

4. Click Send.  

 

3.16.7 Send LE_Accept_CIS_Request to the peripheral device 

When the peripheral device gets a CIS request from the central device, a dialog opens to ask if you want to 
accept the request. 

 

To accept the request, click Yes.  
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On the next dialog that opens, set parameters of the LE_Accept_CIS_Request command and click Send. The 
LE_Accept_CIS_Request command should be sent to the peripheral device within the connection accept 

timeout. 

 

If the CIS is created successfully, the LE CIS Established event is generated. Event information is printed in the 

log window. 
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3.17 Create a BIS between selected devices 

To create a BIS between two devices: 

1. Select the devices. 

2. Enable isochronous channels for the selected devices. 

3. Configure data path for the peripheral device. 

4. Set extended advertising parameters for the central device. 

5. Enable extended advertising for the central device. 

6. Set periodic advertising parameters for the central device. 

7. Enable periodic advertising for the central device. 

8. Enable LE Create BIG Complete event for the central device. 

9. Create a BIG. 

10. Disable advertising reports for the peripheral device (recommended). 

11. Add the central device to the whitelist of the peripheral device. 

12. Enable scanning on the peripheral device. 

13. Add the central device to the periodic advertiser list of the peripheral device. 

14. Enable LE Periodic Advertising Sync Established event for the peripheral device. 

15. Synchronize the peripheral device with the periodic advertising from the central device. 

16. Disable scanning on the peripheral device. 

17. Enable LE BIG Sync Established event for the peripheral device. 

18. Synchronize the peripheral device to the BIG. 

19. Stop receiving the advertising packets. 

3.17.1 Select the devices 

Before you create a BIS between two devices, select the devices. To select the devices, connect two AIROC™ 

Bluetooth® devices to your computer and follow the instructions from the Select a device section. 
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3.17.2 Enable isochronous channels for the selected devices 

To create a BIS between the selected devices, enable isochronous channels for the selected devices: 

1. Select the HCI tab. 

2. Select the LE_ISO_Set_Host_Feature command. 

3. Set the Bit_Number command parameter to 0x20 and the Bit_Value command parameter to Host feature 
is enabled. 

4. Click Send. 
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3.17.3 Configure data path for the peripheral device 

When isochronous channels are enabled for the selected devices, to create a BIS between the selected devices, 
configure data path for the peripheral device: 

1. Select the HCI tab of the peripheral device. 

2. Select the Configure_Data_Path command. 

3. Set the Data_Path_ID command parameter to 0x20. 

4. Click Send.  

5. Set the Data_Path_ID command parameter to 0x21. 

6. Click Send.  
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3.17.4 Set extended advertising parameters for the central device 

When data path for the peripheral device is configured, to create a BIS between the selected devices, set 
extended advertising parameters for the central device: 

1. Select the HCI tab of the central device. 

2. Select the LE_Set_Extended_Advertising_Parameters command. 

3. Set command parameters. 

4. Click Send.  
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3.17.5 Enable extended advertising for the central device 

When extended advertising parameters for the central device are set, to create a BIS between the selected 
devices, enable extended advertising for the central device: 

1. Select the HCI tab of the central device. 

2. Select the LE_Set_Extended_Advertising_Enable command. 

3. Set the Enable command parameter to Advertising is enabled. 

4. Click Send.  
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3.17.6 Set periodic advertising parameters for the central device 

When extended advertising for the central device is enabled, to create a BIS between the selected devices, set 
periodic advertising parameters for the central device: 

1. Select the HCI tab of the central device. 

2. Select the LE_Set_Periodic_Advertising_Parameters command. 

3. Set command parameters. 

4. Click Send.  
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3.17.7 Enable periodic advertising for the central device 

When periodic advertising parameters for the central device are set, to create a BIS between the selected 
devices, enable periodic advertising for the central device: 

1. Select the HCI tab of the central device. 

2. Select the LE_Set_Periodic_Advertising_Enable command. 

3. Set the Periodic_Advertising_Enable command parameter to Periodic advertising is enabled. 

4. Click Send.  
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3.17.8 Enable LE Create BIG Complete event for the central device 

When periodic advertising for the central device is enabled, to create a BIS between the selected devices, 
enable LE Create BIG Complete event for the central device: 

1. Select the HCI tab of the central device. 

2. Select the LE_Set_Event_Mask command. 

3. Open the LE_Event_Mask parameter and check LE Create BIG Complete event. 

4. Click Send.  
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3.17.9 Create a BIG 

When LE Create BIG Complete event for the central device is enabled, to create a BIS between the selected 
devices, create a BIG: 

1. Select the HCI tab of the central device. 

2. Select the LE_Create_BIG or LE_Create_BIG_Test command. 

3. Set command parameters. 

4. Click Send.  

 

If BIG is created successfully, LE Create BIG Complete event is generated and BIS connection handles are 

reported. 
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3.17.10 Disable advertising reports for the peripheral device 

When a BIG is created, to create a BIS between the selected devices, we recommend you disable advertising 
reports for the peripheral device: 

1. Select the HCI tab of the peripheral device. 

2. Select the LE_Set_Event_Mask command. 

3. Open the LE_Event_Mask parameter and uncheck LE Extended Advertising Report Event and LE 
Periodic Advertising Report Event. 

4. Open the LE_Event_Mask (63:32) parameter and uncheck LE BIGInfo Advertising Report Event. 

5. Click Send.  
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3.17.11 Add the central device to the whitelist of the peripheral device 

When a BIG is created, to create a BIS between the selected devices, add the central device to the whitelist of 
the peripheral device: 

1. Select the HCI tab of the peripheral device. 

2. Select the LE_Add_Device_To_White_List command. 

3. Set the WD_ADDR command parameter to BD_ADDR of the central device. 

4. Click Send.  
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3.17.12 Enable scanning on the peripheral device 

When the central device is added to the whitelist of the peripheral device, to create a BIS between the selected 
devices, enable scanning on the peripheral device: 

1. Select the HCI tab of the peripheral device. 

2. Select the LE_Set_Extended_Scan_Enable command. 

3. Set the Enable command parameter to Scanning is enabled. 

4. Click Send.  
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3.17.13 Add the central device to the periodic advertiser list of the peripheral 

device 

When scanning on the peripheral device is enabled, to create a BIS between the selected devices, add the 
central device to the periodic advertiser list of the peripheral device: 

1. Select the HCI tab of the peripheral device. 

2. Select the LE_Add_Device_To_Periodic_Advertiser_List command. 

3. Set the Periodic_Advertising_Receive_Address command parameter to BD_ADDR of the central device. 

4. Click Send.  
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3.17.14 Enable LE Periodic Advertising Sync Established event for the peripheral 

device 

When the central device is added to the periodic advertiser list of the peripheral device, to create a BIS between 
the selected devices, enable LE Periodic Advertising Sync Established event for the peripheral device: 

1. Select the HCI tab of the peripheral device. 

2. Select the LE_Set_Event_Mask command. 

3. Open the LE_Event_Mask parameter and check LE Periodic Advertising Sync Established event. 

4. Click Send.  
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3.17.15 Synchronize the peripheral device with the periodic advertising from the 

central device 

When LE Periodic Advertising Sync Established event for the peripheral device is enabled, to create a BIS 
between the selected devices, synchronize the peripheral device with the periodic advertising from the central 
device. 

Note: Synchronization can occur only when scanning is enabled by the LE_Set_Extended_Scan_Enable 
command. When scanning is disabled, no attempt to synchronize will take place. 

1. Select the HCI tab of the peripheral device. 

2. Select the LE_Periodic_Advertising_Create_Sync command. 

3. Set command parameters. 

4. Click Send.  
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3.17.16 Disable scanning on the peripheral device 

When the peripheral device is synchronized with the periodic advertising from the central device, you can 
disable scanning on the peripheral device: 

1. Select the HCI tab of the peripheral device. 

2. Select the LE_Set_Extended_Scan_Enable command. 

3. Set the Enable command parameter to Scanning is disabled. 

4. Click Send.  
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3.17.17 Enable LE BIG Sync Established event for the peripheral device 

Before you synchronize the peripheral device to the BIG, to create a BIS between the selected devices, enable 
LE BIG Sync Established event for the peripheral device: 

1. Select the HCI tab of the peripheral device. 

2. Select the LE_Set_Event_Mask command. 

3. Open the LE_Event_Mask parameter and check LE BIG Sync Established event. 

4. Click Send.  
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3.17.18 Synchronize the peripheral device to the BIG 

When LE BIG Sync Established event for the peripheral device is enabled, to create a BIS between the selected 
devices, synchronize the peripheral device to the BIG: 

1. Select the HCI tab of the peripheral device. 

2. Select the LE_BIG_Create_Sync command. 

3. Set command parameters. 

4. Click Send.  

 

If the peripheral device is synchronized to the BIG successfully, LE BIG Sync Established event is generated 

and BIS connection handles are reported. 
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3.17.19 Stop receiving the advertising packets 

When the peripheral device is synchronized to the BIG, you can stop receiving the advertising packets on the 
peripheral device: 

1. Select the HCI tab of the peripheral device. 

2. Select the LE_Periodic_Advertising_Terminate_Sync command. 

3. Set command parameters. 

4. Click Send.  
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3.18 ISOC throughput tests 

When a CIS or BIS between the selected devices is created, you can run ISOC throughput tests to check how fast 
ISOC data is transferred between the devices. 

To run an ISOC throughput test, on a device tab or dockable window, select the ISOC Throughput Test tab. 

Note: To run ISOC throughput tests for UART devices, we highly recommend you set the baud rate for 
both devices to 3000000 bps. 

3.18.1 Setup ISO data path 

Before you run ISOC throughput tests, set ISO data path for the selected devices. 

First, set ISO data path for the peripheral device: 

1. Select the HCI tab of the peripheral device. 

2. Select the LE_Setup_ISO_Data_Path command. 

3. Set the Data_Path_Direction command parameter to Output data path (Controller to Host). 

4. Click Send.  
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Next, set ISO data path for the central device: 

1. Select the HCI tab of the central device. 

2. Select the LE_Setup_ISO_Data_Path command. 

3. Set the Data_Path_Direction command parameter to Input data path (Host to Controller). 

4. Click Send.  
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3.18.2 ISOC transmit test 

The ISOC transmit test checks how fast ISOC data is transmitted by a Bluetooth® controller. 

To run the ISOC transmit test: 

1. Expand the Transmit test section of the ISOC test parameters column. 

2. Set test parameters. 

3. Click Start test.  

 

The following table lists parameters of the ISOC transmit test. 

Parameter Description Values 

Connection handle Connection handle of CIS or BIS. A valid connection handle. 

SDU length (bytes) SDU length in bytes. 

Integer values between 1 and 65535. This 

value should correspond to CIS or BIS 

parameters. 

SDU interval (us) SDU interval in microseconds. 

Integer values between 255 and 1048575. 

This value should correspond to CIS or BIS 

parameters. 

Time stamp 
Defines if time stamp should be included in 

ISOC packets. 
Checked or unchecked. 

Write size (bytes) 

Defines the size of data blocks. If not set, the 

size of data blocks is defined by the size of the 

ACL buffer. 

Integer values between 1 and 65535. 
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Parameter Description Values 

Data pattern Sets the data that should be transmitted. 
A space-separated sequence of bytes in 

hexadecimal format. 

Audio file 
A WAV file with the audio data that should be 

transmitted. 
The absolute path to an existing WAV file. 

Repeat count 

Defines how many times the data pattern or 

audio file should be transmitted. Enabled only 

if Data pattern is used. 

Integer values between 1 and 2147483647 

Duration (sec) 

Expected minimum duration of the test (in 

seconds). The actual duration of the test can 

be longer. 

Integer values between 1 and 2147483647. 

Measurement interval 

(ms) 

Defines the time interval (in milliseconds) used 

to calculate throughput. At any moment of 

time, the instant throughput is calculated as 

the number of bytes that were sent during the 

measurement interval, divided by the time 

interval. Throughput values can be calculated 

only when the duration of the test is longer 

than the measurement interval. 

Integer values between 500 and 

2147483647. 

Sync with 

Allows to synchronize the transmit test and 

the receive test for another device. If set, the 

receive test for another device is started 

automatically before the transmit test starts. 

Parameters of the transmit and receive tests 

are synchronized. 

A valid port name of a selected device. 

To check transmit test results, expand the Transmit test section of the ISOC test results column. The 
following table lists test result parameters. 

Parameter Description 

Sent SDU The number of SDU that were sent to the Bluetooth® controller. 

Dropped SDU The number of SDU that were dropped by the Bluetooth® controller. 

Avg. throughput (kbps) 

The average transmit throughput (in kilobytes per second). Transmit 

throughput is calculated as the number of bytes, completed (transmitted or 

flushed) by the controller within the measurement interval, divided by the 

time interval. 

Min. throughput (kbps) The minimum transmit throughput (in kilobytes per second). 

Max. throughput (kbps) The maximum transmit throughput (in kilobytes per second). 

Note: To save the results to a text file, click the Save… link located above the results section.  
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3.18.3 ISOC receive test 

The ISOC receive test checks how fast ISOC data is received by a Bluetooth® controller. To run the ISOC receive 
test: 

1. Expand the Receive test section of the ISOC test parameters column. 

2. Set test parameters. 

3. Click Start test.  

 

The following table lists parameters of the ISOC receive test. 

Parameter Description Values 

Connection handle Connection handle of CIS or BIS. A valid connection handle.  

Data pattern Sets the data that will be transmitted. A space-separated sequence of bytes. 

Audio file 
A WAV file with the audio data that is expected to be 

received. 
The absolute path to an existing WAV file. 

Save to file 
A WAV file to save the received data to. Available 

only if Audio file is used. 

The absolute path to the WAV file to save 

the received audio data to. 

SDU interval (us) 
The SDU interval (in microseconds). Available only if 

Audio file is used. 

Integer values between 255 and 1048575. 

This value should correspond to CIS or BIS 

parameters. 

Repeat count 

Defines how many times the data pattern or data 

file should be transmitted. Enabled only if data 

pattern is used. 

Integer values between 1 and 2147483647 
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Parameter Description Values 

Delay tolerance 

(ms) 

Acceptable time interval (in milliseconds) between 

the time when data is sent to the transmitting 

Bluetooth® controller and the time when the data is 

received by the receiving Bluetooth® controller. The 

measured intervals can be larger than real values. 

Integer values between 1 and 65535. 

Measurement 

interval (ms) 

Defines the time interval (in milliseconds) used to 

calculate throughput. At any time, the instant 

throughput is calculated as the number of bytes 

that were sent during the measurement interval, 

divided by the measurement interval. Throughput 

values can be calculated only when the duration of 

the test is greater than the measurement interval. 

Integer values between 500 and 

2147483647. 

Sync with 

Allows to synchronize the receive test and the 

transmit test for another device. If set, the transmit 

test for another device is started automatically after 

the receive test starts. Parameters of the receive 

and transmit tests are synchronized. 

A valid port name of a selected device. 

To check test results, expand the Receive test section of the ACL test results column. The following table lists 
test result parameters. 

Parameter Description 

Received SDU The number of SDU received by the device. 

Bit errors The total number of bits that were received incorrectly. 

Possibly invalid data The number of packets marked with the “Possibly invalid data” status flag. 

No packet received The number of packets marked with the “No packet received” status flag. 

Avg. throughput (kbps) 

The average transmit throughput (in kilobytes per second). Transmit throughput is calculated 

as the number of bytes, completed (transmitted or flushed) by the controller within the 

measurement interval, divided by the time interval. 

Min. throughput (kbps) The minimum transmit throughput (in kilobytes per second). 

Max. throughput (kbps) The maximum transmit throughput (in kilobytes per second). 

Delayed packets 
The total number of packets that were delayed by more than the value of delay tolerance. The 

measured intervals can be greater than real values. 

Maximum delay (ms) 
The maximum time interval (in ms) between the timestamp when a packet was sent by the 

transmitting device and the timestamp when the packet was received by the receiving device. 

Average delay (ms) 
The average time interval (in ms) between the timestamp when a packet was sent by the 

transmitting device and the timestamp when the packet was received by the receiving device. 

Note: To save the results to a text file, click the Save… link located above the results section.  

The receive test stops automatically if the expected number of bytes is received. Otherwise, you need to stop 
the receive test manually by clicking Abort. 
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3.18.4 Simultaneous ISOC throughput tests 

To run ISOC transmit or receive throughput tests for multiple connections, in test settings, click the ellipsis 
button next to Connection handle. The Connection Handles dialog opens. 

 

Enter the handles of connections for which you want to run the test and click OK. 

Note: When you run a throughput test for multiple connections, you cannot synchronize the receive and 
transmit tests. 

3.19 Program a device 

To program an AIROC™ Bluetooth® device, connect the device to your computer and select Tools > Program 

Device from the main menu or press Ctrl+P. The Program Device dialog opens. 

 

Select Target device to match the device that you want to program and set parameter values. Different target 

devices may have different parameters. When the parameters are set, click Program to program the device. 

Note: If the device is selected in the GUI, the device tab or dockable window closes. For the USB 
transport, the port name of the programmed device can change after programming. 
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3.20 Logging 

The GUI prints information about HCI commands and HCI events in the log window and in the log file. The 
location of the log file is printed in the log window when the application starts. 

 

3.20.1 Clear log 

The Clear Log button will erase the contents of the Log window. You can also select Tools > Clear Log on the 
main menu. 

3.20.2 Show log file 

The Show Log File button opens the location of the log file on disk. You can also select Show Log File on the 

main menu. 

3.20.3 Collapse and expand logs 

The Collapse Logs button shows only the first line of each log message that is printed in the log window. The 

first line of a log message usually indicates the port name and the name of the HCI command or event. The 
Expand logs button shows complete log messages in the log window. 

3.20.4 Filter logs 

The Filter text box will limit messages shown in the Log window to match the filter text. To use regular 
expressions, check the Use Regular expression checkbox next to the filter text box.  

3.20.5 Enable/disable logging 

Toggle the Enable logging checkbox off to disable logging if there is a negative impact on performance. Toggle 

it back on to re-enable logging. 

3.20.6 Replay log 

To send HCI commands from a previously saved log file, select the devices to which you want to send the 
commands. Then, select Tools > Log > Replay log on the main menu. In the dialog that opens, select the log 

file, and click Open. 
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The Replay Log dialog opens. 

 

The following table describes toolbar buttons: 

Button Description 

Send All Send all commands from the selected log file. 

Send One Send the next command from the selected log file. 

Skip One Skip the next command from the selected log file. 

Restart Go to the beginning of the log file. 

Devices 
Allows the user to match port names in the log file and port names of the selected devices. See Device 

matching for details. 

Commands, that are sent successfully, are marked in green. Commands, that are not sent successfully, are 
marked in red. Skipped commands are marked in blue. The status of the latest command is displayed in the 

status bar. 

3.20.6.1 Device matching 

You can match port names of the selected devices and port names in the log file. To match the port names, 
click Devices. The Match Devices dialog opens. 
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The Port Name column contains port names of the selected devices. For each selected device, in the Log Port 
Name column, write a port name which is present in the log file. For example, if Port Name is COM4 and Log 

Port Name is COM12, the commands, which were sent to COM12 in the log file, will be sent to COM4. 

If Log Port Name is not set, Log Port Name is equal to Port Name. 

3.20.7 Log options 

To edit log options, select Tools > Log Options on the main menu or press Ctrl+L. The Log Options dialog 
opens. 

 

The following table describes the available log options and their descriptions. 

Option Description 

Log size limit The maximum number of lines in the log window. 

Data size limit The maximum number of data bytes that can be printed in the logs. 

Ask to save logs when cleared 
Defines if a dialog asks to save the content of the log window to a file when you 

clear the log window. 

Note: Large values of log size limit and data size limit can slow down the GUI. Log size limit affects the 
log window only and does not affect the log files. Data size limit affects both the log window and 
the log files. 
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4 Console application 

This section describes the AIROC™ Bluetooth® test and debug tool console application. 

4.1 Open the console application 

This section describes how to open the console application on different operating systems. 

4.1.1 Windows 

Navigate to the folder where the tool is installed, and run the airocbluetoothtoolconsole.exe executable. 

4.1.2 Ubuntu Linux 

1. To open the  console application, open a terminal and navigate to the folder where the tool is installed. For 
example: 

cd /opt/Tools/AirocDebugTool/<version> 

2. Then, to open the console application, run the airocbluetoothtoolconsole executable. For example: 

./airocbluetoothtoolconsole 

4.1.3 mac OS 

Open a terminal, navigate to the folder where the tool is installed, and run the airocbluetoothtoolconsole 

executable. For example:  

/Applications/AirocDebugTool/<version>/airocbluetoothtoolconsole.app/Contents/MacOS/a

irocbluetoothtoolconsole 

4.2 Command line options 

The following table lists command line options which you can use when opening the console application. 

Option Description 

--help, -h, -? Displays help on command line options. 

--help-all Displays help on command line options including Qt specific options. 

4.3 Open a device 

Before you can send commands to an AIROC™ Bluetooth® device, you have to open the device using the 

console application. To open a device, connect the device to your computer and type the Open command and 

specify the port name. For example: 

open usb0 

Note: In the console application, only one device can be opened at time. To open another device, close 
the device which is already opened. 

4.4 Close a device 

When the device is opened using the console application, to disconnect from the device, type close. For 
example: 

(usb0)$ close 
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$ 

Then, you can open another device. 

4.5 List HCI commands 

When the device is opened using the console application, you can check the list of HCI commands that can be 

sent to the device. 

The HCI commands are grouped in sections. To list all section names: 

list –-section 

For example: 

(usb0)$ list –section 

host_controller_baseband_commands 

informational_parameters 

le_controller_commands 

link_control_commands 

link_policy_commands 

status_parameters 

testing_commands 

vendor_specific_commands 

To list all commands belonging to a specified section: 

list –filter-by-section <section name> 

For example: 

(usb0)$ list –filter-by-section informational_parameters 

read_local_version_information 

read_local_supported_commands 

read_local_supported_features 

read_local_extended_features 

read_buffer_size 

read_country_code 

read_bd_addr 

read_local_supported_codecs 

To list all commands: 

list 

 

4.6 Send HCI commands and receive responses 

To send an HCI command without parameters: 

send <command name> 

If the command generates HCI events, event information is printed. For example: 

(usb0)$ send read_bd_addr 

08/16/21 13:33:23.409  usb0 c> Read_BD_ADDR 

          HCI Command 

        usb0 

        [09 10 00 ] 

        opcode = 0x1009 (4105, "Read_BD_ADDR") 

 

(usb0)$ (usb0)$ 08/16/21 13:33:23.411  usb0 <c Read_BD_ADDR 

          HCI Command Complete Event 
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        usb0 

        [0E 0A ]: 01 09 10 00 DA 26 8E 9E 15 A4 

        event = 0x0E (14,"Command Complete") 

        Num_HCI_Command_Packets = 0x1 (1) 

        Command_Opcode = 0x1009 (4105, "Read_BD_ADDR") 

        Status = 0x0 (0, "Success") 

        BD_ADDR = "A4159E8E26DA" 

To check parameters of an HCI command: 

send <command name> --help 

For example: 

(usb0)$ send write_bd_addr –-help 

 

Usage: send write_bd_addr [options] 

This command will write the value for the device's Bluetooth device address. 

 

Options: 

  -?, -h, --help       Displays help on command line options. 

  --help-all           Displays help including Qt specific options. 

  --bd_addr <bd_addr>  BD_ADDR, The Bluetooth device address 

To send an HCI command with parameters: 

send <command name> <parameters> 

For example: 

(usb0)$ send write_bd_addr –bd_addr FFFFFFFFFFFF 

08/16/21 13:41:12.067  usb0 c> Write_BD_ADDR 

          HCI Command 

        usb0 

        [01 FC 06 ]: FF FF FF FF FF FF 

        opcode = 0xFC01 (64513, "Write_BD_ADDR") 

        BD_ADDR = "FFFFFFFFFFFF" 

 

(usb0)$ (usb0)$ 08/16/21 13:41:12.070  usb0 <c Write_BD_ADDR 

          HCI Command Complete Event 

        usb0 

        [0E 04 ]: 01 01 FC 00 

        event = 0x0E (14,"Command Complete") 

        Num_HCI_Command_Packets = 0x1 (1) 

        Command_Opcode = 0xFC01 (64513, "Write_BD_ADDR") 

        Status = 0x0 (0, "Success") 

4.7 Program a device 

To program a connected device: 

program <parameters> 

Different devices may require different parameters. The following table lists parameters for CYW207xx, 
CYW20819/20, CYW943xx and their descriptions. 

Parameter Description 

--target The target device (CYW207xx, CYW20819/20 or CYW943xx). 

--port Port name. 

--baudrate Baud rate (required for UART devices). 

--btp Path to the BTP file. 
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Parameter Description 

--config Path to the config file. 

--firmware Path to the firmware file. 

--minidriver Path to the minidriver file. 

--dlminidriver Send the download minidriver command. 

--bdaddr New BD_ADDR of the device. 

The following table lists parameters for CYW20829, CYW555xx, CYW89570 and their descriptions. 

Parameter Description 

--target The target device (CYW20829, CYW555xx or CYW89570). 

--port Port name. 

--baudrate Baud rate. 

--minidriver Path to the minidriver file. 

--minidriverlaunchaddress Minidriver launch address. 

--firmware Path to the firmware file. 

--firmwarelaunchaddress Firmware launch address. 

The following are examples of commands to program a device: 

program --target CYW555xx --port COM6 --baudrate 921600 --firmware <path to 

firmware.hcd> 

 

program --target CYW207xx --port COM6 --baudrate 3000000 --btp <path to the BTP file> 

-minidriver <path to minidriver.hex> --config <path to config.hex> --bdaddr 

20706A203323 --dlminidriver  

4.8 Print help 

To get help on the commands of the console application, type help. For example: 

$ help 

 

Commands supported by the application. 

Type <command> -h or <command> --help to get more information about a command 

 

Commands: 

  exit   Close the console and exit 

  send   Send a command to the connected device. Type "send <command> --help" 

           to get more information about a command. 

  List   Lists supported commands 

  close  Disconnect from COM port 

  open   Connect to COM port 

To get help on a specific command: 

<command name> -help 

For example: 

$ list –help 

Usage: list [options] 

Lists supported commands 

 

Options: 

  -?, -h, --help                           Displays help on command line 

                                           options. 

  --help-all                               Displays help including Qt specific 

                                           options. 
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  --section                                list only the section / group name 

                                           of the commands 

  --filter-by-section <filter-by-section>  filter commands by section/group 

                                           Name 

 

4.9 Exit the console application 

To exit the console application, type exit. 
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5 Troubleshooting 

The following table lists possible issues with AIROC™ Bluetooth® test and debug tool and their solutions. 

Issue Possible solution 

A UART device does not respond after being selected. • Check if you have selected the correct port. Some AIROC™ 

Bluetooth® devices have two UART ports, the correct port is 

usually the one with the lower port number or the one 

which has HCI in the port name. 

• Make sure that you are using the correct baud rate. 

On Windows, MSVCP140_1.dll is not found. • Download and install Microsoft Visual C++ Redistributable. 

• Reboot the computer after the installation of Microsoft 

Visual C++ Redistributable. 

On Windows, a USB device does not respond after 

programming. 
• Try another port name for the same device. For example, if 

the selected device was usb0 before programming, try 

usb1. 

On Windows 11, a BTWUSB device (e.g., CYW4373) does 

not respond. 

Turn off memory integrity and assign the BTWUSB driver to the 

connected device. 

To turn off memory integrity: 

1. Tap the Windows Start button. 

2. Type windows security and select the option from the 

search results. 

3. Select Device security. 

4. Select Core isolation. 

5. Turn off the Memory integrity setting. 

6. Reboot the computer. 

To assign the BTWUSB driver to the connected device: 

1. Tap the Windows Start button. 

2. Type device manager and select it from the results. 

3. Locate the connected device which is often found under 

Other devices. 

4. Select Properties from the context menu. 

5. Click Update driver. 

6. Click Browse my computer for drivers. 

7. Navigate to the AIROC™ Bluetooth® test and debug tool 

installation folder and select the drivers subfolder. 

8. Select Next. 

On Ubuntu Linux, a BTUSB device (e.g., CYW4373) does 

not respond. 
• Reinstall the BTUSB driver and reboot the computer. 

On Ubuntu Linux, when opening a device, the error 

0xe0010050 occurs. 

After changing the baud rate for a UART device, the 

error 0xe0010050 occurs. 

• Provide permissions by running 

sudo chmod 777 /dev/ttyUSB* 

(replace * by the correct port number) 
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Issue Possible solution 

On Ubuntu Linux, cannot connect to a device (e.g., 

CYW5557x/CYW89570). 

Add access rights for the group to which the device belongs. To 

add access rights: 

• Run one of the following commands (depending on the 

port name) and check the group name: 

ls -l /dev/ttyUSB* 

ls -l /dev/ttyS* 

• Run the following command to check if the user has access 

rights: 

getent group <group-name> 

• Run the following command to add access rights: 

sudo adduser <user-name> <group-name> 

• Check if access rights are added successfully: 

getent group <group-name> 

• Reboot the computer. 

On Ubuntu Linux, cannot load the Qt platform plugin 

"xcb". 
• Make sure that a monitor is connected to your computer. 

On Ubuntu Linux or MacOS, when programming a 

device, the error “Permission denied” occurs. 

Provide access rights to ChipLoad and cgs executables. To 

provide access rights: 

• Open Terminal. 

• Navigate to the folder where the ChipLoad and cgs 

executables are located. On Ubuntu Linux, they are located 

in the installation folder. On MacOS, they are located inside 

the application bundle, e.g. 

airocbluetoothtoolgui.app/Contents/MacOS/. 

• Execute the following commands: 

sudo chmod 777 ChipLoad 

sudo chmod 777 cgs 

On an embedded Linux platform, cannot open a 

shared object file (e.g., libQt5SerialPort.so.5). 
• Run the application using the *.sh script instead of 

running the executable directly. 

On MacOS, a device cannot be opened. • Remove the lock file by running 

sudo rm -rf /var/spool/uucp/* 

(replace * by the correct port name) 

Connection between the selected devices cannot be 

created. 
• Check if the selected devices need antennas. If the 

selected devices need antennas, connect antennas to the 

selected devices. 

• Make sure that the central and peripheral devices have 

different BD_ADDR. 

• Enable scan on the peripheral device using the 

Write_Scan_Enable command and send the Inquiry 

command to the central device to see if the peripheral 

device is detected. 

• For BIS, make sure that all necessary LE events are 

enabled. 

Throughput values are lower than expected. 

Packet delays are larger than expected. 

A received WAV file sounds broken. 

• For UART devices, increase the baud rate to 3000000 bps. 

• Uncheck the Enable logging checkbox on the log window. 

• Make sure that you are using correct connection settings 

for your devices. 

• Make sure that you are using the latest firmware for your 

devices.  
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Troubleshooting 

Issue Possible solution 

SCO receive throughput test does not receive any data. • You might need to send the Write_SCO_PCM_Int_Param 

command to both devices. 

ISOC receive throughput test does not receive any 

data. 

• Make sure that you have sent LE_Setup_ISO_Data_Path 

to both devices with correct Data_Path_Direction 

parameter values. 

ISOC receive throughput test does not receive all SDU. • Make sure that you are using correct connection settings 

for your devices. 

On Ubuntu Linux, the GUI behaves unexpectedly when 

the user clicks Connect or Disconnect. 

• Make sure that you have selected the correct port name. 

Some AIROC™ Bluetooth® devices have two UART ports. 

Usually, you have to select the port with the lower 

number. 
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Revision history 

Revision Date Description 

** 2018-12-18 New document 

*A 2021-09-20 Document completely updated for new version of the tool. 

*B 2022-09-30 Renamed the tool and updated version to 1.1.0. 

*C 2023-04-13 Updated version to 1.2.0. 

*D 2023-09-25 Updated version to 1.3.0. 

*E 2024-04-11 
Updated version to 1.4.0. 

Added What's New? dialog. 

*F 2024-07-03 Updated version to 1.4.1. 

*G 2024-10-29 Updated version to 1.4.2. 
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IMPORTANT NOTICE 
The information given in this document shall in no 
event be regarded as a guarantee of conditions or 
characteristics  (“Beschaffenheitsgarantie”) .  
 
With respect to any examples, hints or any typical 
values stated herein and/or any information 
regarding the application of the product, Infineon 
Technologies hereby disclaims any and all 
warranties and liabilities of any kind, including 
without limitation warranties of non-infringement of 
intellectual property rights of any third party.  
 
In addition, any information given in this document 
is subject to customer’s compliance with its 
obligations stated in this document and any 
applicable legal requirements, norms and standards 
concerning customer’s products and any use of the 
product of Infineon Technologies in customer’s 
applications.  
 
The data contained in this document is exclusively 
intended for technically trained staff. It is the 
responsibility of customer’s technical departments 
to evaluate the suitability of the product for the 
intended application and the completeness of the 
product information given in this document with 
respect to such application.     
 

 
For further information on the product, technology, 
delivery terms and conditions and prices please 
contact your nearest Infineon Technologies office 
(www.infineon.com). 
 

WARNINGS 
Due to technical requirements products may contain 
dangerous substances. For information on the types 
in question please contact your nearest Infineon 
Technologies office. 
 
Except as otherwise explicitly approved by Infineon 
Technologies in a written document signed by 
authorized representatives of Infineon 
Technologies, Infineon Technologies’ products may 
not be used in any applications where a failure of the 
product or any consequences of the use thereof can 
reasonably be expected to result in personal injury. 

   

Trademarks  
All referenced product or service names and trademarks are the property of their respective owners. 

The Bluetooth® word mark and logos are registered trademarks owned by Bluetooth SIG, Inc., and any use of such marks by Infineon is under license. 
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